Fine art reproduction with digital photography and ink-jet printing
by Brian P. Lawler
This is a revision of a handout that I started eight years
ago. It is a product of practice, research, consulting with
numerous experts, and a good deal of failure.
I made a deal with my friend Carlen that I would
make a reproduction of one of her paintings. The
original hangs in my living room, and she wanted a copy
for display in her studio.

This is my successful reproduction image of Carlen’s roosters painting.
I succeeded with this image because it had a reproducible color palette,
and I was able to get the lighting to work using cross-polarized filters.
Since making this image I have abandoned polarizing filters and adopted
the more correct lighting techniques described in this handout.

I took steps to fulfill my promise to make a copy of her
painting. In some parts of the industry this is called
Fine Art Reproduction. In other parts, it goes by the
pretentious name “giclée” printing. That word is the
French for “squirted” which, I suppose, describes what
an ink-jet printer does to ink on its way to the substrate.
Ask a native French speaker what “giclée” means, and
you’ll learn an altogether different definition that is not
appropriate in a family publication like this (I find this
particularly amusing when talking to art gallery snobs
who refer to their art as being reproduced not by ink-jet,
but by “giclée printing” which is obviously much better).
My task was to photograph, then print a full-size
reproduction of Carlen’s painting. One would think
that this is an easy task, but I knew better. When I had
my business we did a fair amount of reproduction
photography for scanning on our Crosfield scanner.

Anything that we couldn’t wrap around the drum would
be photographed onto 4x5 inch Kodak Ektachrome film,
and then the resulting film was scanned.
I was successful in reproducing Carlen’s painting,
mostly because I was lucky. In subsequent attempts I
have not been so lucky. The color has been unacceptable,
the lighting has been impossible, or a combination of
factors has contributed to various failures.
Fine art photography is a complex task, one
requiring tremendous attention to detail and the
application of care in the selection and placement of
lights and camera, selection of lenses, color management
and reproduction on appropriate papers.
It’s important to the graphic arts and photography
fields because there is money to be made in reproducing
fine art – whether it’s for sale as art, or as an illustration
of art to be printed in a publication or used online.
To reproduce artwork successfully, one must build
a photographic environment conducive to this work,
and develop a work flow that allows for correct lighting,
color management of the source image, and then
reproduction using color management on an excellent
ink-jet printer on an excellent fine art paper.
The first step is to have control over the light in
the photo studio – it must be absolute control. For our
studio work we will be using strobe lights made by Paul
C. Buff Company. These lights are not expensive – they
cost about $600 each, including the radio transceivers
that control them from the camera. Strong light stands
are needed, as two strobe lights are mounted on each
stand, and that is a significant amount of weight.
I built a wall mount for artwork in our studio. It’s
a sheet of plywood machined with parallel T-slots on
which clamps can be added. The plywood was painted
black, then mounted solidly on the wall of our photo
studio.
Space is limited in our studio, so I made the plywood
panel 50 inches square. This allows us to photograph
artwork up to about 36 inches square. Any larger and
we would run out of space for the lights, which must be
placed at a distance from the art and the wall.
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Photographic experts have determined over time that
specific angles must be used to illuminate artwork and
not create reflections. The best ratio for lighting angles is
2.5 horizontal and 2.0 toward the camera. Distance from
the center of the artwork should be adequate to evenly
illuminate the work being photographed without hot
spots.
For our lighting set-up I have chosen a horizontal
radius of 48 inches from the center of the artwork,
which results in a 38 inch distance away from the wall
for the position of the lights. At 48 inches I get adequate
light coverage of the artwork.
Measuring with a tape measure, I marked the wall
with the radius, then measured away from the wall to
position the lights correctly.
The lights are mounted with Super Clamps and 5/8
inch aluminum bars. These bars allow me to position the
two lights on each stand at the same distance from the
artwork, but also above and below the art.

Once they are positioned correctly, they are aimed at the
center of the artwork using a laser mounted to the strobe
light body. I work to get the lights to within a centimeter
of the center of the art – indicated by the target in the
WhiBAL card.
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This is the front view of the fine art reproduction wall. The strobe lights
are mounted on two vertical light stands, each along the radius
of the lighting arrangement.

After mounting the lights to the stands, we need to
position them the correct distance from the center of
the artwork, and the correct distance from the wall.

This is the side view of the same lighting arrangement.

The camera is positioned so that it is square to the
artwork – perfectly square. To do this we use a special
photographic mirror and a mirrored filter for the
camera with a small hole in the center. We suspend the
mirror on the artwork wall, then mount the mirrored
filter on the lens, and look through the filter until we see
a series of concentric circles in the viewfinder.
When positioned correctly, the camera will be less
than 5 arc-seconds off-axis.
The next step is to measure the behavior of the lights
and the camera by making an input profile. This is done
by photographing a standard camera profile target called
the X-Rite ColorChecker SG. It has 140 color patches that
are used to measure and correct the camera’s color with
special software.
To make a proper photograph of the ColorChecker
target (and eventually the fine art we hope to reproduce)
we need to be sure that the exposure is correct, and that
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Here, Professor Van Kleeck positions the camera using the Hasselblad photographic mirror and the Zig-Align mirrored filter on the camera.
You can also see the Einstein strobe lights mounted on the two parallel light stands. The ColorChecker SG is behind the photographic mirror.

the strobes are equally bright over the entire surface of
the reproduction area. To do this we use the incident
light meter on the PCB Cyber Commander radio trigger
device. It measures exposure to 0.1 f-stop. In our initial
tests with this lighting arrangement, all the readings
were within 0.1 stop of each other (in fact they were all
exactly the same).
There will be some differences of opinion of color
temperature between Adobe Camera Raw and the
strobe lights in the studio. To overcome any inaccuracy,
it’s important to record a custom white balance in the
camera prior to making the test photo and the final
photos. To do this, we photograph a WhiBAL gray card
(it’s actually slightly off-white), and then register that
photo in the camera as being the new custom white
point. We use a WhiBAL card that can be mounted on
the wall and photographed to obtain the custom white
balance. Once set, on the Canon camera, this custom
white balance will remain in effect until changed.

After determining that the exposure and white balance
are set, we choose an aperture that allows for a sharp
image with some – but not much – depth-of-field. There
is a “sweet spot” in every lens where the lens is sharpest.
Typically that sweet spot is two f-stops from the largest
aperture of any lens. We’re using an f2.8 lens for this
project, so that sweet spot will be approximately f5.6.
By adjusting the output of the strobe lights (and
ensuring that they are set to constant color output), we
are able to get a good exposure at f5.6. The light output
of the strobes turns out to be minus 5 f-stops to get this
exposure.
Even with correct exposure, we need to make a
bracketed series of exposures to ensure that we capture
the artwork in all of its glory. We shoot a range of two
stops of exposure in 1/3-stop increments (this is the unit
of exposure on the Canon cameras). So, with f5.6 as the
nominal exposure, we make the following exposures:

Copyright 2018 Brian P. Lawler · California Polytechnic State University, San Luis Obispo, California 93407

Version 5.0 · November 20, 2018

f5.6
		
+1/3
		
+2/3
f5.6
		
–1/3
		
–2/3
These exposures can be evaluated on the computer after
we get into the lab, and where we will choose the best
exposure based on the measured CIE-Lab value for L in
each image. We will pick the one that delivers closest to
.95 L value (very near white).
SIDE
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This shows the Hasselblad mirror on the artwork, and the Zig-Align mirror
filter on the camera lens. This combination of tools allows for the precise
alignment of the camera to the artwork, a process that is otherwise very
difficult. Also shown are the aiming laser beams used
to position the lights correctly.

So far I have discussed only how to photograph the
color target, and it is important because we must use
that target to build a Camera Raw profile with which
to import subsequent images into Adobe Photoshop
(or Lightroom). Note that this is not an ICC profile; it
is a different kind of profile that works only in Adobe
Camera Raw.
To build that profile we use an application called
BasicColor Input, from the German software developer

BasicColor. This software is the best on the market, and
is known for making the absolute best input profiles for
digital cameras.
BasicColor can read many Camera Raw files, and
when it encounters one, it makes an appropriate profile
and makes that profile available to the Adobe Camera
Raw software for Photoshop and Lightroom.
(BasicColor Input can also make an ICC profile,
which it will install in the User Library for post
processing if you prefer to use the ICC version.)
Making note of the exposure that produces the best
camera profile, we can return to the studio and shoot
a bracketed series of images of the artwork we plan
to reproduce (remembering to use the custom white
balance setting on the camera).
It’s also important to have a standard grayscale
mounted in the image with the original art. We need to
be able to read white and black in the next processing
steps. I use the grayscale on the Color Checker Passport,
a small target that fits easily along the edge of artwork.
We again take a series of bracketed exposures of the
artwork we’re reproducing following the same range of
exposures we used to make the profile.
Then, using Adobe Camera Raw, we process the
image that is best into Photoshop, applying the profile we
built in the previous step.
First, we apply the profile we made earlier in Adobe
Camera Raw. This will correct the color in the artwork
to within less than 5 Delta-E (the profiles we have been
making exhibit Delta-E errors of 2.35 average, and no
more that 4.5 peak error. That’s exceptional.)
Change the Camera Raw settings to open images in
16-bit color, and change the destination color working
space to ProPhoto RGB – both of these are important
because 8-bit color and Adobe RGB are slightly
inadequate to accommodate the colors in original art.
Two adjustments then need to be made before the
image is opened from Camera Raw. In the Point Curve
control we need to adjust the white value slider until we
get a consistent RGB value of 250 units (each channel
adjusted separately). Once that is accomplished, we
adjust the black end of the curve to get 10 RGB units
(all three channels). This will compress the tone scale a
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This is the ColorChecker SG target we photograph to build the input profile.
It consists of 140 color patches. This target has become the industry standard
for building camera and scanner profiles.

bit, but what we are accomplishing is the customization
of tonality to match the artwork we are reproducing.
We are forcing the black point and the white point
to measured levels that will result in an overall

improvement in color reproduction and gray values.
On completion of those adjustments (and nothing
else!), we open the image in Photoshop.
Once the image is open in Photoshop, we must scale
it to the correct size (the same size as the original), and
make a print on Epson Fine Art paper. This, of course,
requires its own ICC profile to make the color come out
most accurately.
Experiments with these steps will yield small, but
visible changes in the artwork, so be sure to be scientific
and make notes about any adjustments you make in the
camera, in the studio, and in the software. A 1/3-stop
exposure error can ruin the entire process.
And, don’t ever rely on your memory – you can’t.
Bring the original art into the lab to compare to the
image on your computer display and to compare with
the final prints. Stick to scientific processes and the
result will be as successful as your process will allow.

…and this is the image of the Ken Christensen painting that I photographed in the studio recently. With 16-bit color depth, the ProPhoto RGB working color space
applied, and the Camera Raw profile used to convert the image to Photoshop, it is the most accurate fine art reproduction I have ever made.
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Fine art reproduction, step-by-step
1.	Position the artwork on an easel or other surface appropriate for photography. Depending on the size of the
original, estimate the proper distance from the center of the artwork to the lights. I like to use a distance
of two to three times the long dimension of the art, but this is variable. Sometimes there are physical
limitations on where your lights can be placed.
2. Eliminate all spurious light sources – only one source of light should be used.
3.	Determine the light coverage needed to make images in your lighting circumstances. Use this to determine
the distance from the center of your artwork area to the lights in the X direction (along the artwork plane
away from center). Once this distance is determined, calculate the Z direction (away from the art plane
toward the camera) and move your lights that far away from the artwork plane. Think of the X direction as a
circle around the artwork at a fixed distance from center. The X distance should be 2.5 times the Z distance.
4. Install your four lights at the proper X and Z distance from the artwork plane.
5. Place the WhiBAL card in the center of the artwork area with its center target in the middle.
6.	Position the lights with laser pointers, using the target in the center of the WhiBAL card. Each light should
be aimed with the laser so that it is pointed inside the WhiBAL center target (about 1.5 cm. diameter).
7.	Determine the sweet spot of your lens. This is typically an aperture two stops from the largest aperture of the
lens. For example: For the Canon 100mm f2.8 Macro that is f5.6 (or one-third stop either side of f5.6). The
reason for this is that most lenses are not sharp at small apertures, and at the sweet spot you get sharpness
and some depth-of-field for your artwork. With an aperture of 2.8 there is so little depth-of-field that dabs of
paint may be out of focus on the canvas while other dabs of paint are in focus.
8.	Fill the camera frame with the WhiBAL card. With the WhiBAL card in place, determine the correct exposure
(this might be using the camera’s light meter or a hand-held meter). When using strobe flash units, the
exposure is set by the intensity of the strobes. I use an incident strobe light meter to get the perfect exposure,
and I adjust it very slightly once the fine art is in place.
9.	Photograph the WhiBAL card. Then, having made an exposure, check the camera’s LCD to see if the
histogram shows any sign of overexposure (You cannot recover from overexposure). If correct exposure
is indicated on the histogram, assign this photo as a custom white balance on your camera (the process is
similar on all popular cameras). This will define “white” in the camera, and this prevents misinterpretation
of “white” in Adobe Camera Raw or Lightroom.
10.	Remove the WhiBAL card and insert the ColorChecker SG (CCSG) card in place of the WhiBAL card. Then,
using the correct exposure you determined in Step 8, shoot a photo of the CCSG. It may be helpful to set
the focus of the CCSG slightly soft so that the image is of the colors and not of the paint chips in the target.
Once you have made the CCSG photo, remove it, and store it away.
11.	Place the artwork in the center of the subject plane. Move your camera so that it frames the artwork with
a small amount of extra space outside the frame. Put a grayscale into the shot with the artwork; I use an
X-Rite Color Checker Passport with the grayscale in the frame. The grayscale will be very important later
when adjusting the image in Adobe Camera Raw or Lightroom.
12.	Check square. For this I use two optically flat mirrors, one on the artwork, the other on the lens. It is
possible to use small corner marks on tape to accomplish this same task, but the mirrors are more accurate.
My subject mirror is a Hasselblad mirror (you can find them on eBay). The camera mirror is a ZigAlign
mirror that attaches to the Canon lens. When using the mirrors, it’s possible to get the camera perfectly
straight relative to the art; it can be as accurate at 5 arc-seconds. Getting the art square in the camera ensures
that you don’t have to make any distortions in Photoshop to correct for square.
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13.	Be sure that the entire surface of the painting is in sharp focus. I use Live View on my Canon camera to see
critical focus on the camera’s LCD screen – Live View provides both 5X and 10X magnification of the image.
14.	Check exposure at the corners of the artwork. With the Einstein lights I use, I can control brightness in
0.1‑stop increments. Most of the time the exposure is accurate corner to corner, but I occasionally make
0.1‑stop adjustments to get the lighting exactly the same at the four corners.
15.	Take a series of exposures of the artwork. Bracket one stop on either side of nominal in third-stop increments.
16.	Leave the studio set-up in place if possible, taking only the memory card to your computer for the following
steps. This will allow you to return and try again if you need to.
17.	On the computer, transfer the images from the memory card. I prefer to convert to DNG while importing
with Adobe Bridge (see the separate handout on this topic). DNG is important in the next step.
18.	Run BasicColor Input profiling software and set up a workflow that makes a Camera Raw Profile from your
test image. Name the workflow with a name that describes your camera and lighting and exposure. Drag
and drop the properly exposed DNG file onto the BasicColor Input software. It will automatically create
the profile from that image, and it will install that profile automatically in the User Library on the same
computer. This profile will become available immediately to Adobe Camera Raw. (This profile is portable; to
share it with others, you’ll have to go into the User Library, then the Application Support folder, then Adobe,
Photoshop, and Camera Raw Profiles folders to copy it.)
19.	Open the correctly exposed image of your fine art into Adobe Camera Raw (this should be the photo made
at the same exposure as the CCSG). Choose your new Digital Camera Raw profile from the list of available
profiles on the right side of Adobe Camera Raw (you may have to dig for it). It will correct the color to the
greatest degree possible. Do not change the color temperature of the image (that is automatically defined by
the Custom White Balance you set back in Step 8). Leave the white balance setting as: As Shot.
20.	Choose the second tab in Adobe Camera Raw (Curves), then choose Point. Work on individual R,G and B
channels while making the followng adjustments. With the Passport grayscale in the shot, adjust the topright of the curve until the white square in the grayscale turns red (you must turn on the highlight exposure
alarm in the histogram pane first). Once it turns red, move it slightly to the right (2 RGB units) until the red
alarm turns white – just barely.
21.	Adjust the lower-left point of the curve (combined channels) to get the blacks to about 10 on the 0-255 scale.
This will force blacks to be quite dark, but usually quite accurate.
22.	Set the Workflow Options in Camera Raw to 16-bit color and set the color space to ProColor RGB.* Then,
without changing any other settings, Open the image in Photoshop.
23.	Crop the image (and straighten it if necessary). The proportions will be correct, but the dimensions will not
be. Change the dimensions in Image>Image Size, with the Resample checkbox turned off (very important!).
For ink-jet printing the optimal ppi resolution should be about 240. If it’s much less, you may have to use a
higher-resolution camera, or re-shoot the image as a series of photos and stitch them in Photoshop using
Automerge. Ink-jet printing is somewhat forgiving of resolution deficits.
24.	Print your file to an ink-jet printer that you have profiled for paper and ink (an ICC profile). Without a
current and correct ICC profile you will not get the best color reproduction.
25.	After following this simple** checklist, your reproduction should look very similar to the original image.
If not, it may be a result of choosing an incorrect ICC profile for the printer. You can adjust the color in
Photoshop or Lightroom to make small changes, but big errors are usually a result of inattention to detail or
allowing something to change in settings or lighting. Review the process and correct as necessary.
*See the separate handout on 16-bit color and ProPhoto RGB. **Ha!
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An additional note on printer profiles and gallery lighting
On one occasion I was very successful in making a fine art reproduction of an oil painting. I was very happy with the
result in the viewing booth (D50 color temperature). When I returned the painting and took the reproduction to the
artist’s residence, it did not look as good. The colors did not match as they had in our viewing booth.
The painter had low voltage incandescent track lighting in his home. I believe the color temperature of those
lights to be 2700K, but I am not sure. I know that I could make a custom ICC profile for the gallery lighting in his
home. By re-reading the color target I printed on our Epson 9800 printer, and declaring the color temperature of
the viewing condition to a more appropriate value (ISO Illuminant A), the new ICC profile would make the printer
produce art for a lower Kelvin temperature environment. That, I believe, would be more successful.

This is the Jerry Scott painting that I reproduced for the Color Conference. Note the ColorChecker Passport on top of the artwork.
It’s there to provide a grayscale in the image. I use that grayscale to adjust exposure in Adobe Photoshop.
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A pretty good argument for using ProPhoto RGB
as your working color space
Photographers discovered 20 years ago that sRGB is a
really bad color space for professional photography.
So we all changed to Adobe RGB 1998. Bravo!
The reasons for doing so are important: Adobe RGB
has a larger overall gamut, and conversion to CMYK
print gamuts like FOGRA and GRACoL leave colors
largely unchanged. Skin tones are rendered slightly
better in Adobe RGB, and cyan-green colors are possible
in an image, where they are clipped with the much
smaller sRGB color space. It was completely logical.

This is a 3D view of the ProPhoto RGB working color space (available
in Adobe Photoshop) compared to the Adobe RGB 1998 working color space.
The ProPhoto extends beyond the human visual spectrum on the blue axis
in order to accommodate a larger range of violet, cyan and green colors.
It is also very slightly larger along the red-green axis, which includes
the colors described in this essay.

About ten years ago I was counseled by an Adobe
trainer to switch to ProPhoto RGB, a significantly larger
working color space. His argument was strong, but I
didn’t think it affected me. Someday, he argued, Canon
would come out with an ink-jet printer that has such
a huge color gamut that I would love it. If I started
converting all of my images into ProPhoto RGB space
(this is done in Adobe Camera Raw), I would be able to
take advantage of the impressive gamut of that future
printer, and I would enjoy the benefits.
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I followed his recommendation and I switched to
ProPhoto RGB, applying it to all of my images. My
images did not improve (they were just fine in Adobe
RGB), but I felt pretty good about my ability to take
advantage of a future printer with much more color
than my current printer (an Epson 9800). I never
expected my images to improve, but I did want to be on
board when that new huge-gamut printer came along.
To date it has not.
Over the years, probably more a result of staying
in-step with other photographers, I switched back to
Adobe RGB 1998. My photos still look good, and I
seldom get any reminders from the Color Settings palette
reminding me that the color profile I have in my photos
is different than the color settings I have established for
the Adobe Creative Cloud. My work flow just works.
This past week, however, I encountered a situation
while photographing an oil painting where the
difference between ProPhoto RGB and Adobe RGB made
the difference between success and failure.
I have been working for months (years) to learn a
new technique for making reproductions of paintings.
This involves considerable discipline: more accurate
lighting, precise exposure, perfect camera positioning,
building and applying an excellent input profile (applied
in Adobe Camera Raw), and then adjusting the blackpoint and the white-point to get the best possible tone
range in the resulting images.
I don’t want you to think I’m new to fine art
reproduction photography. No, I have been doing it
rather badly for decades. I have spent countless hours
and many dollars building the right set-up, measuring
and preparing the lighting, and taking unacceptable
photos of paintings and other artwork.
In January, 2018 I attended an inspiring seminar
on fine art reproduction by artist/photographer
Christopher Campbell and software developer Franz
Herbert. The two presented at the annual Color
Conference, an event hosted by the Printing Industries
of America. It was the best seminar I have attended in
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years. At the end, Mr. Campbell showed two samples of
paintings and reproductions that were indistinguishable.
Franz Herbert demonstrated BasicColor Input, the
software he develops for BasicColor, a German firm that
makes profiling and profile editing software.

are used to square the camera to the artwork: one goes
on the artwork wall, one goes on the camera lens during
the alignment stage.
Once assembled, I showed my students how the
system works. We set up the ColorChecker SG and we
made exposure calculations to get the images in the
camera – a Canon 6D. We then made profiles using
the BasicColor software, and learned that the errors
in color from shooting to profile were too high: my
average Delta-E was in double-digits. I photographed
the painting and opened it using the profile we made.
Printing that image to Epson Somerset paper we could
see that the color was too orange. Cream colors in the
original were wrong. I worked with the image to make it
look better, but it got worse.

This is a comparison of the ProPhoto RGB working color space (black
wireframe) to the image capabilities of a Canon 6D digital camera.
The size of ProPhoto is important to capture such a large potential volume
of colors captured by that, and similar cameras.

As a result of attending that seminar, and doing
considerable reading after, I developed a work flow and
apparatus for fine art reproduction photography. I built
a special wall mount for paintings; I bought clamps
and aluminum bar stock to mount my strobe lights in
the correct position for this kind of work. I got a new
ColorChecker SG target from X-Rite, and bought a pair
of lasers to aim my lights.
In February I got a copy of BasicColor Input, and
began the process of learning how to make and use
Camera Raw profiles (I have used ColorChecker Passport
for years). In late April, I assembled all of this in the
studio at my university. I brought my own strobes
over (they are arguably better than the lights owned
by my department). I set up my lights, measured their
positions exactly, and then aimed them using the laser.
I bought a Hasselblad alignment mirror on eBay,
and I bought a Zig-Align mirror for the Canon macro
lens I planned to use for this activity. The two mirrors
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This is a projection in 2D of the colors in a recent fine art reproduction image
I made in the studio at my university with the Canon 6D camera. Notice
the colors that extend beyond the triangular gamut of Adobe RGB 1998
at the top-right; these are the cream-yellow colors described in this essay.
This image was created in ColorThink Pro software, which can plot various
color gamuts in 2D and 3D space.

Back in the studio, I recorded a custom white balance in
the camera, a step that I had omitted in the first round
Then I photographed the ColorChecker SG again, and
made a new profile. This one turned out much better:
average Delta-E of 2.46, peak Delta-E of 5.3.
I photographed the painting again and opened the
image in Camera Raw, applying the new profile. On
printing it, the cream colors were much better, but still
visibly wrong.
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In Adobe Camera Raw I changed the bit depth of the
photos from 8-bit data to 16-bit data and tried again.
The result was the same: cream colors that were orange.
I reconsidered everything that I was doing, attempting
to figure out how to make it better. I seized upon the
idea of the color space, wondering if Adobe RGB is
too small for the colors in the painting. I changed the
color space to ProPhoto RGB and tried again. Bingo! I
could tell immediately that the cream colors had been
captured and converted to Adobe Photoshop correctly.

One more thing to consider when choosing a working
color space is whether that space accommodates
colors that are impossible to reproduce (a common
occurrence). ProPhoto RGB “contains” colors outside the
human-visible spectrum, and also outside the gamuts
of most printer/paper combinations. But in this case,
the red-green axis of the Epson ink-jet printer on Luster
paper closely matches that axis of ProPhoto RGB (where
I needed the additional colors), while Adobe RGB falls
slightly shorter of that margin.
ProPhoto RGB
Adobe RGB
Epson 9800 on Luster
Epson 9800 on Somerset

…and this is the same image superimposed on the 2D gamut chart
of ProPhoto RGB. You can see that the larger working space accommodates
nearly all the colors in the photograph, doing a much better job
than its slightly smaller counterpart Adobe RGB 1998.

After analyzing the two gamuts side-by-side, I realized
that the most significant difference between the two
(in this case) is a small strip of land along the redgreen axis, passing through the red-yellow-orange (and
cream) areas of the image. ProPhoto RGB is slightly
larger along this axis (there is not much room to move
there), but this was exactly the area where my colors
were being clipped/mapped into the smaller Adobe
RGB color space, and this was pushing the creams into
stronger reds. When I used ProPhoto RGB, the colors
were being recorded and passed correctly to Photoshop,
and they were remarkably better.
The resulting image, and the print I made from it,
are nearly perfect. It is the most satisfying result that I
have ever made.
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Here are the gamuts of Adobe RGB and ProPhoto RGB color spaces compared
to ink-jet gamuts on the Epson 9800 printer. The largest is ProPhoto RGB,
followed by Adobe RGB. The yellow line describes semigloss Epson Luster
paper; the smallest gamut is Epson Somerset paper, a 100% cotton fine art
paper. ProPhoto RGB is large enough to accommodate (almost) all the colors
in either gamut. Note that Adobe RGB cannot accommodate all the colors in
the Epson-Luster gamut. In fine art reproduction
this can be a critical weakness.

Taking advantage of the larger gamut of colors in
ProPhoto RGB solves a problem. Another painting,
perhaps one with a number of saturated green or
blue-green colors (areas of weakness on all CMYK
printers) might not be served by the ProColor RGB
working space, but it is not any better with Adobe RGB.
I argue that ProColor RGB is the color space to use for
maximum color capture and reproduction.

A pretty good argument for using ProPhoto RGB as your working color space · Version 1.0

The case for using DNG as your primary file type
I have files created by a Kodak branded, Canon-built
digital camera from this century that can no longer be
read. This is my second case of photo file obsolescence;
the first being Kodak Photo CD files that cannot be read
by any existing commonly used software (I did find a
solution to reading Photo CD discs that involves a UNIX
program and using Terminal to control it).
Photos from the old Kodak/Canon camera are not
readable with anything I can find.

The threat of file type obsolescence
The idea of photo files becoming obsolete is a scary one,
because it points out a great threat to society. Sometime in
the future we will no longer be able to access our images
with any existing software.
A few years ago, while preparing for a show in the
local art museum, I scanned a number of five-foot-long
strips of Kodak Cirkut camera film. Some of these film
negatives were more than 100 years old. They still work
perfectly; there are clearly visible images on them, and
they were transferred to digital files by scanning.
I would like to be confident that photos I take today
will still be useful 100 years from now. Current file types
including most camera-specific Camera Raw files will
probably not be legible beyond a decade or two, and the
companies that make the cameras that create proprietary
files have no incentive (in fact they have the opposite) to
support their files beyond a reasonable period of time –
ten years, 20 years?

Innovation drives new camera capabilities
The constant pace of innovation and improvement
in camera technology will drive this. Bigger sensors,
better color capabilities, greater bit-depth, white point
recording, expanded gamuts, and more (perhaps postprocessing focus information can be encoded) will force
camera manufacturers to move to more capable versions
of Camera Raw, and perhaps we’ll have new storage
technologies that supersede the SD card, and others that
we find so handy today. It’s inevitable.
At some point Canon, Sony and Nikon will each say,
“Enough!” for their current storage schemes and they
will move on. Adobe, which now supports hundreds of

different Raw formats, will inevitably abandon support for
the oldest of them and move on.
And that will be the day that we need to go back to
some 30-year-old image and open it anew. But on that day
the image will not open. It will be lost to technological
obsolescence. That will be a dark day.
That day will come soon.
(Ironic note: It’s happening right now! As I write this,
Canon has announced the Canon .cr3 file format, which
will soon make the common .cr2 obsolete.)

We need obsolescence-proofing now
Fortunately we have a solution on hand today, one which
will prevent obsolescence for some time, and one which
we can all adopt immediately to stave-off the possibility of
image obsolescence for a while. The idea of any software
working in 100 years is unlikely, but not unimaginable.
This file is the DNG – or Digital Negative file. It
was created by Adobe in 2004, but has now been made
available by that firm to the world community. It has also
been offered to the International Standards Organization
as an ISO standard, one that can continue to be used in
open-source software, and one that may prevent, or at
least forestall obsolescence.
Archivists are encouraging everyone to use the DNG
file to prevent file type obsolescence.

How do we get to DNG?
The simplest way to put our images into DNG format is
to import images using Adobe Bridge, and its companion
application Photo Downloader.
Photo Downloader does not sport the finest user
interface (far from it!), but it does several things that
no other application can do while simultaneously
downloading images to a computer. It can:
rename
number
sort into date-shot folders
convert to DNG
apply metadata
apply copyright
write copies of the photos to a separate folder
delete the originals after copying them

All but the last of these are features that I use often.
I never delete a photo from a camera card until I am
confident that the images are safely stored on a local
computer. And, even then I don’t erase the camera
memory card until the next time I use the camera.
This software is only available from the File menu in
Adobe Bridge, which is only available to those who have
the Adobe Creative Cloud.
It is also only possible to read photos from a camera
memory card, and not from a folder of existing images.
(Bridge can also read images from a camera connected
by a USB cable to the computer, but that uses a different
application which is not as capable.)

Choose the destination folder in the upper-right
corner. Choose whether to subdivide the images into
folders, and by which criteria (I seldom do this). Then
choose Advanced Rename, and choose Text + Sequence
Number (and other variables that you may want). I always
put a space after the text to separate it from the sequence
number. Be sure to allow enough digits in the sequence
number to accommodate all of your images (and yes,
spaces are valid characters in file names).
And, this is the most important part: Check the
Convert to DNG check box.
You can also add metadata from your own list of
prepared metadata, you can add your own copyright claim
to all of the images, and
you can write copies of the
photos to a back-up disk if
you wish.Then choose Get
Media.

Another scenario:
Converting Camera
Raw images to DNG

Importing photos from a camera card to DNG
This is easy and effective. You put a memory card into
your computer, or to a card reader. Run Bridge, choose
File>Get Photos from Camera, and then choose Advanced
Dialog from the application that opens (it’s called Photo
Downloader).
Once in that application, choose the images you want
to download (start by clicking the UnCheck All button).
You can click on one image, then shift-click on the end
of a range of photos. Non-contiguous selection does not
work in this application, alas.

Suppose you have a folder of
Camera Raw photos on your
hard drive, and you want
to convert them to DNG.
You would want to do this
to create a DNG archive of
images from those photos
you have already stored on
your hard drive.
To convert one or more
images from Camera Raw
to DNG, chose a batch of images and hit Command-O
(Open). This will cause the images to open in Adobe
Camera Raw. You might get a warning dialog indicating
that you have selected a large number of images to open at
one time. Click Continue.
Once they open in Camera Raw, select all
(Command-A). Then choose the Save Images button in the
lower-left corner of the window.
A new dialog will open. Choose Save in Same
Location (or you can save in a new location). Choose
.dng as the image suffix, which will automatically select

files. You can continue to
do other things while this is
happening.

Converting with the
Adobe DNG Converter

the conversion to DNG (though you can overrule this –
don’t!).
Click the Save button in the upper-right corner.
It will take about one second per image to convert the

Another technique is to
use the free Adobe DNG
Image Converter. Download
this and install it on your
computer. It has a logical
interface. This application
can convert Camera Raw
images in any folder into
DNG files. It does so quickly
and effectively.
Once the conversion is
complete, you will have a
folder with .dng files in it. Those images are saved in the
most obsolescence-proof format currently available.
You can be confident that your photos will work in
the future. How long? No one knows, but I
assure you it will be longer than if you do
nothing with your files.
If you take steps to import all new
images into your computer in DNG format,
and to archive your photos in DNG format,
you may be able to avoid the dark day when
you will no longer be able to read your
photo files.

Note:
DNG will not convert from JPEG images.
The file format is limited to Camera Raw
files.
I am confident that JPEG images will be
legible for many years, due to their ubiquity.
But, JPEG is not a good format for archival
images because of the damage done to
images as they are converted to JPEG.
— Brian P. Lawler, December, 2018
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Adobe Bridge
Get Photos from Camera…
Rename and add sequence number (Advanced Rename)
(optional) sort into subfolders
according to date
(optional) Add copyright claim
(optional) Append metadata template
(optional) Save copies of the images
Convert to DNG

